Tutorial Seven: The Theory Builder

This tutorial introduces you to the Theory Builder, HyperRESEARCH’s model-building tool, and follows the creation and implementation of two sample theory tests.

Understanding the Theory Builder

HyperRESEARCH’s Theory Builder, like the Report Generator, supplies a set of tools that allow you to examine and work with your codes in ways not practical with the basic code generation and manipulation tools available at the study window. Specifically, the Theory Builder can help determine whether or not your coding supports any assumptions and inferences you may have concerning your study.

The Cinderella Study

For demonstration purposes, we’ll use a very simple study with a simple theory.

While other tutorials use the “QDA Study” materials, we’ll use another sample study, the “Cinderella Study,” to introduce you to the Theory Builder.
Dr. Sharlene Hesse-Biber collected the data for the sample Cinderella Study. The subjects were undergraduate female students of qualitative sociology at Boston College. These women described what they hoped their lives would be like 20 years in the future, when they would be about 40 years old.

The Cinderella Study proposes that a majority of college age women have idealistic views of their futures. From the material presented in this sample study, you will soon see why we called it the Cinderella Project. Note: The Cinderella Study material is not a fully developed research study; it is intended solely as sample material to illustrate the Theory Builder.

Developing a Theory

Before working with the Theory Builder, you must develop a theory about your data.

Launch HyperRESEARCH

Open the Cinderella Study

Browse the Cinderella Study

Develop a Theory

For the Cinderella Study example, the theory is “these young women tend to have an unrealistic view of life – a Cinderella Complex.”

This theory can be stated as follows:

Most of the respondents hope that in 20 years they will have both a successful career and a happy family life. They do not foresee significant troubles or problems arising while they try to reach these goals or once these goals have been achieved. Their hopes for these dual successes, combined with their innocence of difficulty, indicates that these women have an unrealistically optimistic view of life — a Cinderella Complex.
Defining the Theory in HyperRESEARCH Terms

Once you have formulated a theory, you must express it in terms HyperRESEARCH can understand. This is easier than it might sound. All you have to do is break the theory down into its basic points, then list each point in simple terms. Here are the Cinderella Complex Theory’s basic points:

- The respondents have a high commitment to their careers.
- The respondents also have a high commitment to their families.
- Pursuing both these goals might lead to conflicts.
- Some respondents foresee no potential conflicts — they have a Cinderella Complex.

These points come from our theories about the Cinderella Study’s data. If the source material was coded correctly, the codes should reflect these points. Let’s review the Cinderella Study’s list of codes to see which codes can support each point.

Review Cinderella Study Codes

Make sure the Cinderella Study is open, and that “All Codes” and “All Cases” are visible in the Study window. If not, use the Filter Codes… and Filter Cases… commands to filter all codes and cases.

Also make sure that the Code Book is displayed on your screen. If it’s not, choose the “Code Book” command from the Codes menu.

Familiarize yourself with the Cinderella Study’s codes in the Code Book.

Look for Relevant Codes

Three codes describe the respondents’ commitment to their careers: “I am making a high salary,” “fabulous nontraditional job,” and “great job on return nontraditional.”
Several codes describe the respondents’ commitment to their families: “family before career,” “gets married and stays married,” “takes time off for young kids,” “mom belongs at home with young kids,” “places family needs above self,” “takes major responsibility for family work,” “takes major responsibility for raising kids,” and “wants kids.”

Define Inferences

The third point in our theory — that pursuing both these goals might lead to conflicts — is an inference we make as researchers.

We assume that respondents who have a high commitment to their careers and a high commitment to their families are likely to experience conflict between the two. This point is not supported directly by the source material — it’s something we infer from the presence of both career-oriented and family-oriented codes.

Define Goals

The fourth point in our theory is the point we’re trying to prove — that the young women who have a high probability of conflict between career and family but do not foresee any potential conflicts have a “Cinderella Complex.”

This is the “goal” of the Cinderella Theory.

Only those respondents who have a high potential for conflict and foresee no potential conflicts will meet this “goal.” If these young women do show a high degree of commitment to their careers and do show a high degree of commitment to having families, and don’t expect to experience problems achieving both goals, they do have unrealistically optimistic views of life.

Redefine Theory in terms of Code Names Used

Now we need to define our points in terms of our codes.

Each point in a HyperRESEARCH theory consists of two parts; one or more “assumptions” and an “inference.” Both assumptions and inferences can be expressed in terms of codes. For example, the points of the Cinderella Theory could be expressed in the following terms:

• If a case contains the codes “I am making a high salary” and “fabulous nontraditional job,” we can infer the respondent has a high work commitment. We can add a new code (“HIGH WORK COMMITMENT”) to the case.

• If a case contains the codes “gets married and stays married” and “wants kids,” we can infer the respondent has a “HIGH FAMILY COMMITMENT.”

• If a case’s codes indicate both a high work commitment and a high family commitment, we can infer there is a high potential for work and family conflict (“HIGH POTENTIAL FOR WORK FAMILY CONFLICT”).

• If a case indicates a high potential for work and family conflict, and contains the codes “combine work and family no problems” or “successful happy life,” we can infer the respondent has the Cinderella
You will see that it’s easy to translate a theory stated in these terms directly to expressions and commands HyperRESEARCH can understand.

Inferences and Inference Paths
In a well-constructed theory, there is a logical path cases must follow through the points to reach the “goal.”

In the Cinderella Complex example, the first point must prove true for a case to have any chance of reaching the goal. So, too, must the second point. The third point is true only for those cases that met the criteria in the first two points, and so on.

Note that points can be based on assumptions you’ve inferred from previous points. The third point in the Cinderella Theory is an example: it’s based on the assumptions “HIGH WORK COMMITMENT” and “HIGH FAMILY COMMITMENT,” which in turn were inferred from codes present in the data.

You can also combine “inference codes” with the codes assigned to your data. The fourth point in the Cinderella Theory, for example, combines the codes “combine work and family no problems” or “successful happy life” with “HIGH POTENTIAL FOR WORK FAMILY CONFLICT,” which we inferred (in the third point) from the presence of both a “HIGH WORK COMMITMENT” and a “HIGH FAMILY COMMITMENT.”

The points should be constructed in an “IF” — “THEN” format, which is easy for HyperRESEARCH to interpret. In a well-constructed theory, a sequence of “IF” — “THEN” expressions lead from basic assumptions about the data, through assumptions inferred from the truth of the basic assumptions, to the final goal of the theory. This path through the “IF” — “THEN” expressions in a HyperRESEARCH theory is called an “inference path.”

As you construct a theory, try to keep your “inference path” in mind. That should help you decide what steps (or points) you must include and when you have reached your theory’s “goal.”
The Theory Builder window

Once we’ve formulated our theory and decided on the appropriate codes to represent the theory’s basic points, we’re ready to construct the theory in the Theory Builder window.

Open the Theory Builder window

With the Cinderella Study open in HyperRESEARCH, choose “New Theory” from the Theory menu.

HyperRESEARCH presents the Theory Builder window.

There are three distinct sections to the Theory Builder window: the “Theory Rule List” section, the “IF” section, and the “THEN” section.

The “Rule List” section simply lists the Rules that translate your theory into terms HyperRESEARCH can understand. As you build expressions and define actions, these Rules are added to the list until your theory is complete. Currently, the Rule List section is empty, as you have not yet applied any Rules to your theory.

The “IF” section represents the “assumption” portion of a HyperRESEARCH “Rule” (a single point of your HyperRESEARCH theory). The “Build Expression” popup menu lets you define the underlying assumptions of each point in terms of the absence or presence of certain codes. The “Clear IF” button will remove the current “IF” expression if you make a mistake.
HyperRESEARCH Tutorials

The “THEN” section represents the “inference” portion of a HyperRESEARCH “Rule.” The “Actions” popup menu lets you tell HyperRESEARCH what to infer if the conditions in the “IF” section are met. The “Clear THEN” button will clear any actions in the THEN window if you make a mistake.

The “OK” button to the right of the THEN window adds the completed rule to the Rule List. The “Prev Rule” — “Next Rule” arrows allow you to cycle through your rule set as necessary; the current rule number is also displayed.

*Note: If you do not see the “IF” and “THEN” sections below the Rule List section, click on the arrow next to the Show Rule Editor option. Clicking on this arrow toggles the display between the Rule List section only and the full Theory Builder window.*

**The Theory Menu**

With the Theory Builder window open, the Theory menu shows several available commands (not just “New Theory” or “Open Saved Theory Settings” as when we first chose the “New” command).

Using the Theory menu, you can start a new theory; save your theory as a separate file, or open a saved theory.

You can add a new rule to your Rules List (once you have defined the rule using the IF and THEN sections), or clear or remove your current rule.

To have HyperRESEARCH test your theory (once you have a complete set of rules in the Rules List), choose the “Display Theory Results” command (to display the results on the computer screen) or the “Export Theory Results” command (to export the results to a text file).

**Constructing the Theory Rule List**

Any point you test with HyperRESEARCH’s Theory Builder is called a Rule.

A Rule has two parts: codes that define your assumptions, and what you infer from those assumptions. For example, the presence of two codes “I am making a high salary” and “fabulous nontraditional job” on a respondent’s case may lead you to infer that she is highly career-oriented. The two codes are the assumptions that support the inference.
HyperRESEARCH treats this combination of assumptions (codes) and inference as a Rule, and checks a Rule’s validity against the available data (coded source materials) whenever you run a test.

Another way to think about Rules is in terms of cause and effect. The codes are the causes; the inference is the effect. For example, you could say that “if a respondent indicates that she wants to make a high salary and have a fabulous, non-traditional job, then she shows a high degree of career orientation.” HyperRESEARCH uses this cause-and-effect, if-then method of understanding Rules. If these two codes are present in any case, then we can safely say that the respondent is career-oriented.

If a Rule’s assumptions prove true, HyperRESEARCH can use that Rule’s inference to support further Rules. It does this by treating inferences as codes, although these “inference codes” are based on the presence or absence of given codes rather than any statements inherent in the source material. This will become clearer as we work through the Cinderella Complex theory example.

Building a Rule involves three steps: building an expression (the assumptions, or cause), determining an action (the inference, or effect), and entering the Rule in the Rule List.

Building Expressions: The “IF” Section

Choose “Code…” from the Build Expression pulldown menu

The first expression we want to build for the Cinderella Complex theory will use the “I am making a high salary” and “fabulous nontraditional job” codes to show that the respondents are highly career-oriented.

With the Cinderella Study loaded into HyperRESEARCH and a new Theory Builder window open, choose “Code…” from the “Build Expression” pull-down menu to select the first code for the expression.

Select the “I am making a high salary” code.

HyperRESEARCH brings up the Code Selection Dialog Box. Select the code you need to build your expression. In the Cinderella Complex example, the first code of the expression should be “I am making a high salary.” You may need to scroll down to find the code.
HyperRESEARCH Tutorials

Once you’ve selected the proper code, HyperRESEARCH adds it to the IF section.

Open the “Build Expressions” pull-down menu again.

The menu now shows Boolean operators (AND and OR) you can use to build the expression. For the first rule in the Cinderella Theory, select “AND.”

HyperRESEARCH returns you to the Theory Builder window, with the selected Boolean operator added to your expression.

Click and hold on the “Build Expression” button again, and choose the “Code…” command to add the next code to the expression.

HyperRESEARCH brings up the Code Selection Dialog Box again.
Select the “fabulous nontraditional job” code.

HyperRESEARCH returns you to the Theory Builder window, with the second code added to the expression in the “IF” section.

Note: in your own theories, you may continue selecting Boolean operators and codes until your expression is complete. Remember to put parentheses around appropriate code subset if necessary (as we did in earlier tutorials when filtering codes or cases by criteria).

Determining Actions: The “THEN” section

Now that you’ve selected the codes to support a point — by building an expression in the “IF” section — you can determine the action (or inference) that will result when the expression is found to be true. These actions may be one of three types: adding a goal; adding a code; or removing a code. Let’s take a closer look at each of these actions.

• Adding a Goal: With this action, you are marking a Rule as the end-point in a path through a set of inferences (derived from previous Rules). This lets HyperRESEARCH know that if a case meets the criteria in the “IF” portion of the rule, the theory has been shown to be true for that case. While it is possible to have multiple goals in a theory, most theories will have a single goal. Each case within a study may reach at most one goal. (See “Complex Theories,” later in this tutorial, for more information.)

• Adding a Code: This action tells HyperRESEARCH to temporarily add the specified code to any case for which the accompanying expression is true. This “theme code” or “inference code” is inferred from the presence or absence of certain codes in the case rather than from specific source material. Such “theme codes” appear in the Theory Test Report, and are added to the Code Book (thereby allowing you to use them in building expressions for additional Rules). In the Cinderella Complex example, those cases which have both the code “I am making a high salary” and the code “fabulous nontraditional job” will be assigned the inference code, “HIGH WORK COMMITMENT.” If you have the “Add Themes to Cases” option checked, theme
HyperRESEARCH Tutorials

codes will appear in the affected cases and in the Code Book on a more permanent basis. (We’ll explore this option later in this tutorial.)

• **Removing a Code**: This action tells HyperRESEARCH to temporarily remove a code from any case for which the accompanying expression is true. If you have the “Add Themes to Cases” option checked, this will permanently remove all references to the specified code from any case for which the accompanying expression is true. HyperRESEARCH will present a dialog box warning you when the action of a Theory rule will result in the removal of one or more codes, at which point you can allow or deny the action.

Adding Actions: The “THEN” Section:

To specify an action (or inference) in the “THEN” section, click and hold the “Actions” button to access the pulldown menu.

Choose the “Add Code…” action.

HyperRESEARCH brings up the “Pick a code to add…” dialog box with your code list.

We want to add the code “HIGH WORK COMMITMENT” to any case for which the expression “I am making a high salary AND fabulous nontraditional job” proves true.

There is no such code as “HIGH WORK COMMITMENT,” so we’ll create a new one.

Click on the “New Code…” button and type in “HIGH WORK COMMITMENT.”

HyperRESEARCH adds “HIGH WORK COMMITMENT” to your code list. With this new “theme” code highlighted, click Select to apply it to the current theory Rule.

*Note: We suggest you name “theme codes” with all uppercase letters, or*
HyperRESEARCH Tutorials

with the naming convention of “Theme [Individual Code Name]” or some similar method that distinguishes “theme codes” (assigned by the Theory Builder based on the “IF” expressions) from actual codes assigned directly to the source material.

HyperRESEARCH returns you to the Theory Builder window, with the appropriate action and code appearing in the “THEN” section.

Click OK to add Rule to Rule List

With the first rule complete (an expression and an action), click OK to add the rule to your Theory Rule List.

HyperRESEARCH displays the rule in the Rule List section, clears the “IF” and “THEN” sections, and updates the Rule Number in the lower right corner from “1” to “2”. You are now ready to enter Rule 2.

Completing the Rule List

Completing the Rule List is simply a matter of building expressions and defining actions until your entire rule set is complete.

Build Rule 2:

Now build the expression for Rule 2. For the Cinderella Theory, the
expression should read “IF gets married and stays married AND wants kids” and the action should be “THEN ADD HIGH FAMILY COMMITMENT.”

Choose the “Code…” option from the Build Expressions pull-down menu and select the “gets married and stays married” code.

Next choose the “AND” operator from the Build Expressions pull-down menu.

Then choose the “Code…” option from the Build Expressions pull-down menu once more, and select the “wants kids” code.

For the action for Rule 2, choose the “Add Code” option from the “Actions” button’s pull-down menu.

Create a new code, “HIGH FAMILY COMMITMENT.”

When you’ve selected the new code and HyperRESEARCH has entered it into the “THEN” section, click on the “OK” button to add the new rule to the Rule List.
Build Rule 3:

“IF HIGH WORK COMMITMENT AND HIGH FAMILY COMMITMENT THEN ADD HIGH POTENTIAL FOR WORK FAMILY CONFLICT”

Repeat the process for the third Rule.

Build Rule 4:

IF HIGH POTENTIAL FOR WORK FAMILY CONFLICT AND (combine work and family no problems OR successful happy life) THEN ADD GOAL “GOAL: CINDERELLA COMPLEX”

The fourth and final rule should read “IF HIGH POTENTIAL FOR WORK FAMILY CONFLICT AND (combine work and family no problems OR successful happy life) THEN ADD GOAL “GOAL: CINDERELLA COMPLEX””

Use the Build Expression pull-down menu to build the “IF” expression.

Remember to use parentheses to “clarify” the expression (this is necessary any time you are using “AND” and “OR” operators in your Boolean expressions).

To clarify the expression, first build the “HIGH POTENTIAL FOR WORK FAMILY CONFLICT AND combine work and family no problems OR successful happy life” expression.

Then click once on the “combine work and family no problems” code and once on the “successful happy life” code.

HyperRESEARCH asks if you wish to apply parentheses to the selected portion of the expression. Click “OK.”
Now create the “THEN” portion of Rule 4. This time choose the “Add Goal…” option from the Actions pull-down menu.

Name the goal “GOAL Cinderella Complex”

*Note:* as with “inference” code names, we suggest that you adopt a naming convention for Theory “GOALS” that makes it clear that they are distinct from your codes.

Once Rule 4 is complete, click “OK” to add it to the Rule List.
You should now be able to see the entire Cinderella Complex theory in the Theory Rule List section. (You may need to scroll through the window or resize it to view all four rules.)

![Theory Rule List](image)

Testing and Analyzing Your Theory Report

Once you have the appropriate Rules entered in the Theory Builder window, you may tell HyperRESEARCH to test your theory and produce a report. As with the Report Generator, the Theory Builder allows you to display the test results on your computer screen, export the test results to a text file, or print the test results.

Display Tests

To see the results of HyperRESEARCH’s test of the Cinderella theory, you will need to “Display” it.

First, determine whether or not you wish to “Add Themes to Cases” (inference codes will actually be added to the case’s code references, rather than remaining temporary codes applied only for the purposes of the theory test.)

Then click on the “Display” button under the Theory Rule List.

*Note:* You may run a Theory Test against a subset of cases in your study by filtering specific cases, using any of the Case Filter options, and then choosing to Display or Export the report. If you wish to test all cases in your study, make sure you’ve filtered “All Cases” before running the test.

HyperRESEARCH tests yours Rules against each currently filtered Case in your study and displays a Theory Test Window with the results, paginated by case.
The Test Display Window

The Test Display Window is similar to the Report Display Window provided by the Report Generator. As with the Report Display Window, HyperRESEARCH assigns a temporary report name to each theory test report.

The current page number is shown in the upper right hand corner. You can page through the test report by clicking on the left- or right-arrows flanking the page number. (The Theory Test Window presents one case per page.) If the report for any case is longer than can fit on the screen, you may use the scroll bar to the right of the Test Display Window to scroll through the current page.

A quick summary of the Theory Test results appears on the first page:

1 out of 8 cases supported this theory.

The results for each case follow:

Testing your Theory on Case: Case 01
The following rules were found to apply to this case:

   Rule 2 was applicable:
       IF gets married and stays married AND wants kids
       THEN ADD HIGH FAMILY COMMITMENT

Not enough rules could be found to be applicable to this case to reach the GOAL of your hypothesis. Therefore, your hypothesis has been shown to be 'not supported' for this case.

Analyzing the Results

Let’s examine the Cinderella Complex Theory test results in detail.
Case 01

Here’s what we see on Page 1 of the Cinderella Complex Theory Test Window:

1 out of 8 cases supported this theory.

Testing your Theory on Case: Case 01
The following rules were found to apply to this case:

   Rule 2 was applicable:
      IF gets married and stays married AND wants kids
      THEN ADD HIGH FAMILY COMMITMENT

Not enough rules could be found to be applicable to this case to reach the GOAL of your theory.
Therefore, your theory has been shown to be 'not supported' for this case.

The first line is a general summary for the test as a whole (1 out of 8 cases tested reached the theory test’s “goal”).

The results of the test for Case 01 follow this summary.

HyperRESEARCH found only one Rule to be “true” for Case 01.

Rule 2 was found to be “true” because Case 01 was coded with both the “gets married and stays married” and “wants kids” codes.

Rule 1 was not found to be “true” (Case 01 has been coded with “I am making a high salary” but not “fabulous nontraditional job” so does not meet the criteria for Rule 1).

Because Rule 1 was not found to be “true” for Case 01, Rules 3 and 4 could not be found to be “True.”

Cases 02 Through 04
Case 02 yields results similar to Case 01. HyperRESEARCH could only support Rule 1: the respondent’s interview was coded with “I am making a high salary” and “fabulous nontraditional job” — but not with “gets married and stays married” and “wants kids.”

Likewise, HyperRESEARCH could not support the Cinderella Complex Theory for Cases 03 and 04.

Here are the results for Cases 02 through 04:

Testing your Theory on Case: Case 02
The following rules were found to apply to this case:

   Rule 1 was applicable:
      IF I am making a high salary AND fabulous nontraditional job
      THEN ADD HIGH WORK COMMITMENT
Not enough rules could be found to be applicable to this case to reach the GOAL of your theory. Therefore, your theory has been shown to be 'not supported' for this case.

Testing your Theory on Case: Case 03
The following rules were found to apply to this case:

Rule 2 was applicable:
   IF gets married and stays married AND wants kids
   THEN ADD HIGH FAMILY COMMITMENT

Not enough rules could be found to be applicable to this case to reach the GOAL of your theory. Therefore, your theory has been shown to be 'not supported' for this case.

Testing your Theory on Case: Case 04
The following rules were found to apply to this case:

(none)

Not enough rules could be found to be applicable to this case to reach the GOAL of your theory. Therefore, your theory has been shown to be 'not supported' for this case.

Case 05 Test Results
Paging further through the test report, we can see that HyperRESEARCH found the Cinderella Complex Theory true for Case 05. Let’s examine this case in detail:
Testing your Theory on Case: Case 05
The following rules were found to apply to this case:

Rule 1  was applicable:
  IF I am making a high salary AND fabulous nontraditional job
  THEN ADD HIGH WORK COMMITMENT

Rule 2  was applicable:
  IF gets married and stays married AND wants kids
  THEN ADD HIGH FAMILY COMMITMENT

Rule 3  was applicable:
  IF HIGH WORK COMMITMENT AND HIGH FAMILY COMMITMENT
  THEN ADD POTENTIAL FOR WORK FAMILY CONFLICT

Rule 4  was applicable:
  IF POTENTIAL FOR WORK FAMILY CONFLICT AND ( combine work and family no problems OR successful happy life )
  THEN GOAL REACHED GOAL: CINDERELLA COMPLEX

Enough rules were found to be applicable to this case to reach the GOAL of your theory.

Therefore, your theory has been shown to be 'supported' for this case.

The Case 05 report tells us that Rule 1 was applicable to Case 05. HyperRESEARCH found both the “I am making a high salary” and “fabulous nontraditional job” codes in this case. Having found both codes, HyperRESEARCH added the “HIGH WORK COMMITMENT” inference code to Case 05 — for the duration of the theory test.

Rule 2 was also applicable to this Case 05. HyperRESEARCH found both the “gets married and stays married” and “wants kids” codes among Case 05’s assigned codes. Having found both codes, HyperRESEARCH temporarily added the “HIGH FAMILY COMMITMENT” code.

Rule 3 was also applicable to this case. That’s what we’d expect. We already know the conditions for inferring the “HIGH WORK COMMITMENT” and “HIGH FAMILY COMMITMENT” codes existed. HyperRESEARCH built on both these new codes when testing Rule 3, and added the “HIGH POTENTIAL FOR WORK FAMILY CONFLICT” inference code to Case 05’s code list.

The test supported the fourth (and final) Rule as well. We know that the respondent already had a “HIGH POTENTIAL FOR WORK FAMILY CONFLICT.” Case 05’s source material must also have indicated the respondent thought she would be able to combine work and family with no problems, or that she would have a successful happy life (the case’s code list must have included either “combine work and family no problems” or “successful happy life” — or both). HyperRESEARCH therefore added the “CINDERELLA COMPLEX” goal, and announced that Case 05 had reached the theory goal — as per the “Actions” specified for Rule 4.

The page sums up by saying that HyperRESEARCH found sufficient support for the theory within this case; this particular respondent has a “Cinderella Complex.” She has unrealistic expectations of a successful, easy life.
Cases 06 Through 08 Test Results

Moving on to the other cases, it’s easy to see that Case 06 through Case 08 are as disappointing as Case 01 through Case 04. HyperRESEARCH did not find the supporting codes necessary to allow any case but Case 05 to reach the theory goal.

___________________________________________________________________

Testing your Theory on Case: Case 06
The following rules were found to apply to this case:

Rule 2 was applicable:
   IF gets married and stays married AND wants kids
   THEN ADD HIGH FAMILY COMMITMENT

Not enough rules could be found to be applicable to this case to reach the GOAL of your theory.
Therefore, your theory has been shown to be 'not supported' for this case.

___________________________________________________________________

Testing your Theory on Case: Case 07
The following rules were found to apply to this case:

Rule 2 was applicable:
   IF gets married and stays married AND wants kids
   THEN ADD HIGH FAMILY COMMITMENT

Not enough rules could be found to be applicable to this case to reach the GOAL of your theory.
Therefore, your theory has been shown to be 'not supported' for this case.

___________________________________________________________________

Testing your Theory on Case: Case 08
The following rules were found to apply to this case:

Rule 2 was applicable:
   IF gets married and stays married AND wants kids
   THEN ADD HIGH FAMILY COMMITMENT

Not enough rules could be found to be applicable to this case to reach the GOAL of your theory.
Therefore, your theory has been shown to be 'not supported' for this case.

Why So Few “True” Results?

It may seem odd that HyperRESEARCH found the theory to be true only for Case 05 when it ran the theory test. Our initial browsing of the study and source material probably left us with the impression that many respondents hoped to combine a satisfying career with a satisfying family life; few mentioned expected difficulties.

But only Case 05 had the necessary codes to support our theory.

Here are some things to consider when the Theory Builder seems to disprove something you felt sure about in the data:
Some codes may not really describe the source material well enough. For example, the respondent in Interview 08 says that she eventually wants to be a freelance writer and teach theology at the college level. In the Cinderella Study, this passage was coded as “nontraditional field” — but perhaps it should really have been labeled “fabulous nontraditional job.”

Perhaps other “nontraditional field” codes should also have been coded “fabulous nontraditional job.” If some of the “nontraditional field” codes were changed to “fabulous nontraditional job,” that would change the number of cases that would meet the criteria for Rule 1.

We also started simply, taking only a few of the codes into account when writing the Rules for the Cinderella Complex Theory. If the Rules included more of the codes showing work and family commitments — or if they required only one of the selected codes to be present, rather than both or all — that would also change the number of cases for which the theory would be found true.

**Fine-Tuning Your Theory**

The Theory Builder cannot actually prove or disprove your study’s theme or theory — only you, the researcher, can do that.

The Theory Builder can, however, help you discover where your coding may be weak, or where your theory may need refining. Once you’ve run your first theory test, you may need to fine-tune your theory. This is especially true if the test results are not quite what you expected.

Let’s continue with the Cinderella Complex Theory example. We’ll edit Rule 1, expanding it to reflect the data more accurately, and see whether that will increase the number of cases for which HyperRESEARCH will find the theory true.

**Editing a Theory’s Rule List**

Let’s edit the Cinderella Complex theory.

To do this, we’ll need to bring the Theory Builder window back to the front of our computer screen.

You may click in the “close box” for the Theory Test Window to close that window. If any other windows are obscuring the Theory Builder window, you may either click on a visible part of the window you wish to bring it to the front, or choose the “Theory” window from the Window menu.

*Note: If the Theory Builder window is no longer open, you can open the*
HyperRESEARCH Tutorials

saved version of the Cinderella Complex theory that was included with the tutorial materials. Choose “Open Saved Theory Settings” from the Theory menu to open a saved theory. The Cinderella Complex theory is named “Cinderella Complex Hyothes.hhp” and is in the Cinderella Study folder.

Browsing a Theory

The “Prev Rule” — “Next Rule” arrows below the “OK” button to the right of the “THEN” section lists the currently displayed Rule.

Click on the up-arrow to back up to the previous Rule; click on the down-arrow to advance to the next rule.

Edit Rule 1: “Clear IF”

Display Rule 1 in the Rule Editor (IF/THEN sections). (Click on the Prev Rule arrow until Rule 1 appears if it’s not already shown.)

Click on the “Clear IF” button above the “IF” section to remove Rule 1’s expression. This allows you to enter a new expression without changing the “Actions” portion of the rule. (Likewise, clicking on the “Clear THEN” button allows you to alter the “Actions” portion without changing the rule’s expression.)

Note: If we were going to alter both the expression and the action portions of Rule 1, we would choose the “Clear Current Rule” command from the Theory menu.

Rebuild Rule 1 Expression

Rebuild the expression for Rule 1 to redefine the codes HyperRESEARCH will be examining.

In this updated Cinderella Complex Theory, we want HyperRESEARCH to search for either “fabulous nontraditional job” or “nontraditional field,” as well as “I am making a high salary.”

Use the Build Expression pull-down menu to build the updated “IF” statement:

(fabulous nontraditional job OR nontraditional field) AND I am making a high salary
HyperRESEARCH Tutorials

Remember to “clarify” the expression by clicking on the “fabulous nontraditional job” and “nontraditional field” codes and placing parentheses around these. Otherwise HyperRESEARCH will be looking for either “fabulous nontraditional job” or both “nontraditional field” and “I am making a high salary” — not quite what we’re looking for.

When you’ve built the new expression, click on the “OK” button to the right of the “THEN” section to enter the rule in the Rule List (just as you did when you first created the rule).

HyperRESEARCH brings up a dialog box asking you to confirm that you want to enter the rule in the Rule List. You have three options: to Cancel the operation, to Replace the original rule 1, or to create a New rule.

In the Cinderella Complex Theory example, we want to “Replace” the original Rule 1 with the updated version we just entered.

When you click on the “Replace” button, HyperRESEARCH replaces the original rule with the current, modified rule.
Satisfying Results

If we run the Cinderella Complex Theory test again (using the “Display” button), we’ll see that HyperRESEARCH now finds the theory true for Case 07 and Case 08 as well as for Case 05.

Furthermore, Case 01 now satisfies all Rules but Rule 4. Going back to Case 01’s source material, we can find that if we code the passage “I guess I’m really lucky that my life turned out almost exactly like I always wanted it to” with the code “successful happy life,” our modified theory will also be true for Case 01.

We could continue this process — modifying the theory’s Rule List and refining the codes in our study — until we achieve the results we’re looking for.

Adding Theory “Themes” to Your Cases

One of the options you have with the Theory Builder is to have the “Actions” portion of your Theory rules actually change things (add or remove codes) on your cases. You do this by choosing the “Add Themes to Cases” option.

With the “Add Themes to Cases” option unchecked, when you run a Theory test, all of the actions (the addition of or removal of codes, etc.) are temporary. The cases themselves remain unchanged. With the “Add Themes to Cases” option selected, these actions apply to the code references and cases in your study as well.

Let’s see this in action.

Open Cinderella Complex Theory

With the Cinderella Study open in HyperRESEARCH, choose “Open” from the Theory Builder and choose the “Cinderella Complex Hypothes.hhp” theory test setting file.

“Add Themes to Case”

Make sure the “Add Themes to Cases” box is checked (active), then Display the theory test.

Review Results

Now go back to your Study window to look at the codes applied to the Cinderella Study cases.

In the Cinderella Complex Theory example, checking “Add Themes to Cases” results in the following changes to the cases:

Case 01:
HIGH FAMILY COMMITMENT added

Case 02:
HIGH WORK COMMITMENT added

Case 03:
HIGH FAMILY COMMITMENT added

Case 04:
no change (none of our Theory Rules tested true for Case 04, hence there were no Actions taken)
HyperRESEARCH Tutorials

Case 05:
HIGH WORK COMMITMENT added
HIGH FAMILY COMMITMENT added
POTENTIAL FOR WORK FAMILY CONFLICT added

Case06:
HIGH FAMILY COMMITMENT added

Case 07:
HIGH FAMILY COMMITMENT added

Case08:
HIGH FAMILY COMMITMENT added

Note: If you are using the modified theory that loosens the restrictions for Rule 1 by looking for “fabulous nontraditional job OR nontraditional field” as well as “I am making a high salary,” your results will be a bit different. Case 01 and Case 07 will have the HIGH WORK COMMITMENT and POTENTIAL FOR WORK FAMILY CONFLICT Theme codes added as well.

Each of these newly added code references show their “Source” as “Cinderella Complex Hypothes.hhp,” their “Type” as “THEME,” and their Reference as “1,” “2,” or “3” – representing the Rule number of the Rule that tested as true and resulted in the Action that added the theme code.

Using Theme Codes For Case Filtering

Once you’ve applied Theme codes to your cases, you can use those codes for case filtering purposes. Each Theme code essentially marks that case as having a specific combination of codes (the presence and absence of certain codes) based on the Theory rule or rules that generated the Theme code.

To continue with the Cinderella Study example, once you’ve run the Cinderella Complex theory with “Add Themes to Cases” checked, use the “Filter Cases -> By Criteria” command to filter cases based on applicable Theme codes.

In the Case Filtering Criteria dialog box, choose “Code…” from the “Build Criteria” drop-down menu. Select the HIGH WORK COMMITMENT code from the code list. Make sure that “Cases to Test” is set to “All,” then click Select to apply the filter to your study.

HyperRESEARCH will filter two cases containing the HIGH WORK COMMITMENT theme code: Case 02 and Case 05. These are the cases for which Rule 1 of the Cinderella Complex theory proved true. Filtering by the HIGH FAMILY COMMITMENT theme code instead will result in six cases being filtered (all except Case 02 and Case 04).

Filtering cases based on the presence of the POTENTIAL FOR WORK FAMILY CONFLICT theme code results in one case being filtered: Case 05. This is, of course, the case for which the Cinderella Complex theory was supported.
HyperRESEARCH Tutorials

(Note: If you’re using the modified version of the Cinderella Complex theory with the updated Rule 1 that we created when fine-tuning the theory, Case 01 and Case07 will also be filtered.)

The “Remove Code” Action and Adding Themes to Cases

The Cinderella Complex theory does not use the “Remove Code” action in its Rules list, so in the example above the “Add Themes to Cases” option only added codes, it didn’t remove codes from any of the Cinderella Study cases.

However, you may use the “Remove Code” action in theory tests of your own. Just be aware that if you choose to “Add Themes to Cases” with a theory that includes one or more “Remove Code” actions, HyperRESEARCH will permanently delete the specified codes from any case for which that particular Rule tests as true.

To see this at work, let’s add a “Remove Code” action to Rule 1 of the Cinderella Complex theory.

Start Fresh: Revert to Saved or Open Cinderella Study

If you are working with a copy of the Cinderella Study that already has some theme codes added to the cases, either choose “Revert to Saved” from the File menu to clear those codes or open the original version of the Cinderella Study. This will avoid duplicating those codes by running the theory again with “Add Theme Codes to Cases” active.

“Remove Code:” takes major responsibility for raising kids

With the Cinderella Complex theory open in the Theory Builder window, and Rule 1 showing in the IF/THEN sections of the window, choose “Remove Code” from the Actions pull-down menu.

Choose the code “takes major responsibility for raising kids” to be removed.

Update Rule 1

With the “THEN” portion of Rule 1 showing “ADD HIGH WORK

Tutorial Seven: The Theory Builder 167
COMMITMENT” and “REMOVE takes major responsibility for raising kids,” click the “OK” button. HyperRESEARCH reminds you that you already have a Rule 1: choose “Replace” to update Rule 1.

Test the Updated Theory

With Rule 1 of the Cinderella Complex theory updated to include the action “REMOVE takes major responsibility for raising kids” and the “Add Themes to Cases” option active, click “Display” to run the theory and display the results.

Warning: Allow or Deny

Because applying the Actions of Rule 1 to your study would result in the removal of codes from one or more cases, HyperRESEARCH presents a warning dialog box.

Click “Allow” for Case 02 and Case 05

Click “Allow” to have any instances of “takes major responsibility for raising kids” from Case 01. Click “Deny” if you wish to cancel this action.

HyperRESEARCH presents this warning dialog box for each case that may be affected, so you can allow or deny the removal of a code on a case-by-case basis.

Click “Allow” a second time to have any instances of “takes major responsibility for raising kids” from Case 05 (the other case for which Rule 1 tests as true).

Verify Removal

Now go back to your Study window to see the effects of this Action.
Case 02 didn’t actually have any instances of “takes major responsibility for raising kids” so the only change to this case is the addition of the HIGH WORK COMMITMENT theme code.

Case 05 did have one instance of “takes major responsibility for raising kids” (referencing the same source material as the “combining work and family” code reference). Based on the Action portion of Rule 1, “Add Themes to Cases” resulted in the addition of three codes (HIGH WORK COMMITMENT, HIGH FAMILY COMMITMENT, and POTENTIAL FOR WORK FAMILY CONFLICT) and removed one code (takes major responsibility for raising kids).

Take Care when Adding Themes to Cases
As you can see, the “Add Themes to Cases” feature is quite powerful and can make lasting changes to your cases and code references. So some care is needed when using this feature.

When running a theory with “Add Themes to Cases” checked, keep in mind that if you run a theory more than once you will be duplicating Actions, applying additional sets of theme codes to your cases. This may not be a bad thing, just something to keep in mind as you work with the Theory Builder.

Even more care should be taken when any of your Rules include the “Remove Code” action as this may remove code references that were coded directly from your sources. If you plan to “Add Themes to Case” and wish to use the “Remove Code” action, it may be best to restrict code removal to “theme” codes that were previously applied to your cases, either in previous Rules in the current theory or in a previous running of the theory.

One way you can do this is to create a new code that will only be used as an “inference code” (as with HIGH WORK COMMITMENT and the other theme codes we used in the Cinderella Complex theory). This theme code could be added by one Rule based on the criteria set in the “IF” portion of the Rule, and removed by a later Rule based on different criteria (quite possibly allowing instances of the theme code to remain on some cases while removing it from others).

Saving and Retrieving Theories
As with the Reports menu, the Theory menu allows you to save and retrieve the settings (expressions, actions, and Rules List) of theories as well as the test reports themselves.

Saving Your Theory
The Theory menu allows you to save the expressions, actions, and Rules List of any theory simply by choosing the “Save Theory Settings As…” command from the Theory menu. You may thus develop multiple theories for your studies, retrieving them as necessary.

To save the current settings of the Theory Builder window, choose the “Save Theory Settings As…” command from the Theory menu.
“Cinderella Update” HyperRESEARCH brings up a standard Save File Dialog Box. Name the theory appropriately (“Cinderella Update” might be a good name for this theory, as it contains the updated Rule 1 we just entered) and save it into an appropriate folder or directory.

Retrieving Saved Theories
You may open any saved theory, thereby replacing the current settings in the Theory Builder window with the saved theory settings.

Open Saved Theory Settings Choose the “Open Saved Theory Settings” command from the Theory menu.
HyperRESEARCH Tutorials

Open “Cinderella Complex.hhp”

HyperRESEARCH brings up a standard Open File Dialog Box, allowing you to locate and select the theory settings you wish to open.

Go ahead and open the original “Cinderella Complex.hhp” file included with the tutorial materials.

Note: in HyperRESEARCH, theory test setting files are saved with the “.hhp” file extension to distinguish them from saved report settings (“.hrp”) or exported tests (“.txt”). HyperRESEARCH automatically adds this file extension to the filename you enter in the Save As… dialog box so you don’t have to worry about it.

HyperRESEARCH clears all current settings in the Theory Builder window, replaces the current Theory Rule List with the one we just opened, and displays Rule 1 in the Rule Editor (the “IF” and “THEN” sections).

You may now alter the theory testing parameters, display the test report to the screen, export the report to a text file, or send the report to your printer (by displaying it to the screen and choosing “Print…” from the File menu).

Note: If you open a theory that was created in another study, HyperRESEARCH will present the following error message:
Your choices are “OK” and “Cancel.”

If you opened the theory test in error, choose “cancel.” If you wish to run the same theory test against the data sets in more than one study, choose “OK.” HyperRESEARCH will open the theory.

You should of course be using the same code names in the current study as you did in the study in which you originally created the theory test, or you’ll get “not supported” results.

Saving (Exporting) Test Results
HyperRESEARCH allows you to save the test results as well as the Theory Builder window settings.

Export Theory Test Results to Text File
To save a theory test’s results report, make sure there’s a complete theory test in the Theory Test Rule List. (The “Cinderella Complex” theory that came with the tutorial files should currently be loaded.)

Export…
Choose the “Export Theory Results” command from the Theory menu, or click on the “Export…” button in the Theory Builder window.

HyperRESEARCH asks you to name the file you wish the results saved in:
Make sure you’re saving the file into the correct folder or directory (where you’ll be able to find it again).

You may name it whatever you like (we used “Cinderella Complex Results” in the example above). HyperRESEARCH will save it as a text-only file.

If you wish, you may open the file in your favorite word processing program to examine the exported Theory Test results. It’s essentially the same report you see on the screen when you choose to “Display” a HyperRESEARCH theory, but in a text format you can work with in other programs.

Exported theory test reports may be opened as source material to code in your current study or another study.

**Printing Theory Rules Lists and Test Reports**

You may also print the displayed test results or your Theory Rule List.

To print a theory test result, first create or load a theory Rule List in the Theory Builder window.

Then “Display” the test.

HyperRESEARCH will create a Theory Report and display it in the Theory Test Report Window.

Choose “Print…” from the File menu.
HyperRESEARCH will send a copy of your test results to your printer.

If you wish to change the format of your test report before printing, you may add headers and footers and set margins through the “Page Layout” command in the File menu.

Or you may Export the test results and make any desired formatting changes in your word processor, then print from your word processor.

**Print Rule List**

To print your Theory Rule List, make sure the Theory Builder window is at the front with the Theory Rule List shown.

Then choose “Print…” from the File menu.

HyperRESEARCH sends a copy of the currently shown Theory Rule List to your printer.

**Complex Theories**

The Cinderella Complex theory example is a relatively simple theory. There’s a straightforward path through the inferences we make, and a case must meet all the conditions to reach the theory goal. Only one action is associated with each expression.

But the Theory Builder allows you to set up and test much more complex theories. Each rule may result in as many actions as you deem necessary, and you may have as many rules as you wish. You may set up multiple paths to your theory goal, or even multiple goals in a single theory (although HyperRESEARCH will allow each case to reach only one goal). You can temporarily remove codes (whether previously coded from the data itself or applied as a “theme code” during the theory test) — or permanently, if you have the “Apply Themes to Case” option turned on. Rules may look for the absence of codes as well as their presence, and so on.

For an example of a more complex Theory test, open the QDA Study and then open the “QDACategories Theory.hhp” file provided with the study. The “QDA Category Theory” uses multiple goal paths to categorize the cases based on the presence and absence of certain codes.
HyperRESEARCH Tutorials

For researchers interested in testing complex theories, we provide the following information about the Theory Builder and how it works as an “inferencing engine.”

The Theory Builder as an Expert System Shell

HyperRESEARCH’s Theory Builder is an “expert system” shell which uses forward-chaining production rules — applied to a knowledge base made of the codes in each case — to automatically test theories. (Forward-chaining simply means the inference paths move forward, beginning with the data and ending with the theory goal.)

By treating the presence or absence of codes as indicating a true or false value for that code, HyperRESEARCH creates a knowledge base. This knowledge base is made of all the cases in the study and the individual codes for each case.

The code list represents the list of unique codes used in the study. A theory is represented by a set of production rules built upon the code list.

A production rule’s basic form is that of an implication, or inference: IF some set of conditions is true THEN infer some set of conclusions to be true. The specific syntax of a rule is of the form IF Expression THEN Actions. Production rules are used to express inferences from the codes. A single rule describes the inference of one or more new codes, not coded from the data directly, but inferred from the presence of other codes in the same case. In a sense, a rule functions to condense the existence of several related codes into one or more new codes. A production rule’s conditions, or “expression” portion, may be based upon the conclusions of previous rules. This allows you to develop a logical chain of proposed inferences to model your theory about the data.

When you test a theory, HyperRESEARCH’s inference engine applies the rule set to each case, comparing the codes used in each expression with the actual codes appearing in each case. If a code in the expression appears in the case, it will evaluate to true; else it will evaluate to false. If the entire expression evaluates to true then all actions listed for that rule will be applied to the case.

Rule Order in the Theory Builder

You may find it helpful to enter your rules in the order that follows your chain of reasoning, as though each rule were a signpost on the path of inferences you expect to take. In other words, if your reasoning chain has a particular order (If A Then B; If B Then C; If C Then D; and so on) that order should be reflected in the rules set.

Sometimes, especially with complex theories with multiple inference paths, you may not be able to follow such a straightforward ordering scheme. In these cases, you’ll need to know in what order HyperRESEARCH tests the rules.

The Theory Builder (inference engine) tests the rules in cycles, or “passes.” In each pass, the inference engine checks to see if the expression portion of each Rule is true. If it is, the engine places it in the selection list. Once the engine has selected all expressions which are true on this pass, it “fires” the rule with the lowest rule number. (When the Theory Builder “fires” a rule, it executes the action portion of the rule and removes the rule from further consideration in testing the current theory on the current case.)

After firing the rule with the lowest rule number of all those whose expressions were found to be true in a given pass, the engine returns to the original rule list (now minus the rule which was fired) and repeats the selection process.
HyperRESEARCH Tutorials

The inference engine terminates the test for a given case when one of two conditions are met:

1) It fires a rule whose action portion includes a “GOAL REACHED” marker

or

2) There are no more rules eligible for selection.

Let’s follow the test for Case 05 of the Cinderella Study, using the Cinderella Theory discussed throughout this chapter. We already know the Theory Builder finds the theory true for this Case 05, but let’s see what order it fired the rules in and how many passes it took.

**Pass 1:** The inference engine applies the expression portion of each rule to the code list for Case 05. It selects Rule 1 (IF I am making a high salary AND fabulous nontraditional job) and Rule 2 (IF gets married and stays married AND wants kids) as testing true. Rule 3 (IF HIGH WORK COMMITMENT AND HIGH FAMILY COMMITMENT) and Rule 4 (IF HIGH POTENTIAL FOR WORK AND FAMILY CONFLICT AND (combine work and family no problems OR successful happy life)) prove false on this pass, and are not selected.

The inference engine fires Rule 1 (it has the lower rule number), adding the code HIGH WORK COMMITMENT to Case 05. HyperRESEARCH removes Rule 1 from the rule list for this case.

**Pass 2:** Rule 1, having fired successfully in the last pass, is no longer available for selection. The inference engine selects Rule 2 (IF gets married and stays married AND wants kids) as testing true. Rule 3 and Rule 4 again test false on this pass.

The inference engine now fires Rule 2, the only rule selected as true for this pass. As per Rule 2’s action portion, the Theory Builder adds the inference code HIGH FAMILY COMMITMENT to Case 05, and removes Rule 2 from the Rule List for this case.

**Pass 3:** The inference engine now selects Rule 3 as true. Previous passes have added both the HIGH WORK COMMITMENT and HIGH FAMILY COMMITMENT inference codes, and have also made Rules 1 and 2 ineligible for further consideration.

The Theory Builder fires Rule 3, adding the inference code HIGH POTENTIAL FOR WORK AND FAMILY CONFLICT to Case 05 and removing Rule 3 from the rule list.

**Pass 4:** There is now only one rule left in the Rule List for Case 05: Rule 4. The inference engine selects Rule 4, as it tests true for this pass.

The Theory Builder adds the inference code CINDERELLA COMPLEX and the marker GOAL REACHED. It ends its test now — having found the theory to be true for Case 05 — and begins anew with Case 06.

**The Theory Builder and Directional Coding**

As you can probably see, the Theory Builder requires you to consciously code your data for the presence or absence of a given phenomenon, rather than coding for content alone.

In the QDA Study, the “computer experience” code is an example of a code that has not been named or applied with a “direction” in mind. The “computer experience” code was simply used as a label for passages in which correspondents mentioned their level of computer experience, from “newbie” to expert. This code would not be a good candidate for use in a theory test. Hyper-
RESEARCH would have no way of distinguishing between the varying levels of computer use marked by the “computer experience” code.

On the other hand, the “ease of use important” code is a “directional code.” It marks passages in which respondents indicated that they felt that the ease of use of a given qualitative data analysis software package was important (rather than marking any passage in which the respondent discusses ease of use issues in any way). A code named “ease of use not important” would also be a “directional” code.

When setting up “directional” coding, you can even name your codes to indicate varying positions along a polarized scale. For example, you could have such codes as “first-time computer user,” “basic computer literacy,” “competent computer user,” “experienced computer user,” and “computer guru.”

These directional codes can then be used to create fairly powerful and in-depth analyses using the Theory Builder.

**Multiple Goals and Inference Paths**

If you set your codes up properly — indicating varying positions along a polarized scale — you can then set up multiple goals in your theory to reflect various degrees of support for that theory. Your goals might range from completely negative support (cases which test true for the opposite of your theory) to full support, with degrees in between.

**For More Information**

For more information, we suggest you read the following sections in the HyperRESEARCH User’s Guide (accessed through the HyperRESEARCH Help menu):

**HyperRESEARCH Reference:**
- Windows:
  - Theory Builder
  - Display Results Window
  - Study window
- Menus:
  - Theory Menu

**HyperRESEARCH in Depth:**
- Analysis:
  - Testing Theories
  - Including Codes of Type Theme
  - Expressions and Filtering Criteria
  - Code Proximity Functions